Introduction: Low Noise Measurement System

A system for measuring noise spectral density conssts of three important parts. SR785
Dynamic Sgnd Andyzer, EG& G 5184 UltraLow Noise Voltage Preamplifier, and
SR715 LCR meter. Function and characteristics of each individua part will be described
next. A block diagram of the complete noise spectrum measurement systemisshownin
chapter 4.

SR785 Dynamic Signal Analyzer

SR785 Dynamic sgnd andyzer isadud channd and makes use of Fast Fourier
Transform (FFT) to obtain the spectral density of an input voltage signd. The resolution
of the measurement is based on the display span and the number of spaces between the
data points on the display. When the input is not periodic the FFT is computed on the
bass of the highly distorted waveform at the ends of the time record. The signd andyzer
solvesthis problem by using window functions. Other features of thissgna andyzer is
various types of averaging which is necessary in a given frequency range to reduce the
variance of thefina plot. Further more, the trace storage, retrieva, capture buffer and
math function are used to store and subtract background noise and transformation from
the find measurement.

EG& G Ultra LowNoise Voltage Preamplifier

The excess noise generated by aresistance sample used in the experiment isinther V to
hV range. The senstivity of a SR785 sgnd andlyzer islimited to detect input noise of
about 10 hV/OHz a 200 Hz. For this reason avery low noise amplifier is needed to
amplify the noise Sgnd to amplitude large enough to drive an input of the Sgna

andyzer. The gain provided by the preamplifier is 60 dB (fixed).

SR715 L CR meter

The resstance of a sample changes when an electric current is flowing through it. In our
measurement we have to keep track of the resistlance when the current is flowing through
it. LCR meter is capable of measuring the resistance, inductance and capacitance when
current is flowing through the device,

In the coming sections we will briefly discuss about these instruments and ingtructions to
use them.



Chapter 1
SR 785—100 kHz Two channel Dynamic Signal Analyzer

Getting started

The examples measurements in this chapter are desgned to acquaint the firg time user
with the SR785 Dynamic Sgnd Andyzer. They provide the foundaion for
understanding how to use SR785. For a more complete overview of the insrument and its
capabilities, refer to the SR785 operating and programming reference.

Some of these examples use the test filter. The filter is a Smple twin-T 1 kHz passve

notch filter. This filter provides an interesting frequency response for these
measurements.

In This Section
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Front Panel Quick Start

Things To Watch Out For

Anayzer Basics

Analyzing a Sne Wave

Measuring a Frequency Response Function
Linking (Advanced operation)

User math Functions



Overview

Power switch

The power switch is located on the rear pand. Depressng the upper haf of the
power switch turns on the SR785. The green power LED on the front pand
indicates that the unit is powered. The video display may teke a few seconds to
warm up and become visble. The brightness is adjusted using the [Brighter] and
[Dimmer] buttons below the softkeys. The firmware revison, serid number,
memory Sze and cdibration dates of the unit are displayed when the power is
turned on.

Video display

The monochrome video display is the user interface for data digplay and front
pand programming operations. The brightness is adjusted usng the [Brighter]
and [Dimmer] buttons below the softkeys. The contrast is adjusted using
[Al][Dimme]. To extend the life of the disdlay, use the Screen Saver in the
[System] <Preferences> menul.

Keypad
The keypad congsts of four groups of hardkeys (keys with printed labels).

Hardkeys are referenced in braces like [Active Display] or [Input].

The ENTRY keys ae used to enter numeric parameters, which have been
highlighted by a soft key. The MENU keys sdect a menu of soft keys. Pressng a
menu key will change the menu boxes, which are displayed next to the soft keys.
The CONTROL keys gsart and stop data acquidtion, toggle the active display and
link parameters and functions. The FUNCTION keys perform common functions
such as Auto Scale and Auto Range. These keys can be accessed at any time.

Softkeys

The SR785 has menu driven user interface. The MENU keys each display a menu
of Softkeys. The softkeys are at the right of the video display and have different
functions depending upon the displayed menu.

Softkeys are referenced in brackets like <Span> or <Units>.



Knob

There are three types of Softkeys — buttons, lists and numeric vaues. A button
performs a function, such as <Full Span>.

A lig presents a lis of choices or options in the entry fied (a the top of the
screen). Use the knob to make a selection and press [Enter]. <Measurement> is an
example of a lig. A numeric vaue presents the current vaue in the entry fiedd and
awaits numeric entry. Enter a new vaue with the ENTRY keys and pess [Enter].
<Start Freg> is an example of anumeric value.

For complete description of the menu softkeys, refer operating manudl.

The knob normaly moves the markers within the displays. If a parameter has
been highlighted by its softkey, the knob adjusts the parameter. Parameters, which
have a lig of choices are most easly modified with the knob. Numeric entry
fields may aso be adjusted with the knob.

Disk drive

The 35" disk drive is used to store data and instrument settings. Double sided,
high-dendty disks have a capacity of 1.44M bytes. The disk format is DOS
compatible.

Use the [Disk] menu to format adisk or access disk files.



Features

DC to 102.4 kHz bandwidth

90 dB Dynamic range

16- bit A/D converson

Low Digtortion Synthesized

ANSl Standard Octave Measurements

145 dB Dynamic Range Swept Sine Mode
Order Tracking

20 Pole/Zero Curve Fitting

TimeHisogram

8 Msamples Transient capture memory
Interna and externd Triggering

File Output to SDF, MAT, UFF, and ASCII
Graphics Output to GIF, EPS, PCX, HPGL
3.5” MS-DOS Compatible Disk Drive
GPIB and RS-232 Interfaces Included
Windows Data Viewer Program Included

The SR785 two channds Dynamic Signd Andyzer is a precison, full-festured signd
andyzer that offers state-of-art performance and awide sdection of features.

Standard measurement groups include FFT, order tracking, octave, swept Sne wave,
correlaion, time capture and timehisogram. The SR785 brings the power of severd
indruments to an application: a spectrum andyzer, network andyzer, vibraion anadyzer,
octave andyzer and oscilloscope. Unique measurement architecture dlows the SR785 to
function as a typicd dua channd andyzer with measurements like cross spectrum,
frequency response, coherence etc. Alternately, the ingrument can be configured so that
each input channe functions as a sngle channd andyzer with its own span, center
frequency, resolution, and averaging. This dlows you to view a wide band spectrum and
smultaneoudy zoom in on spectrum detaills. The same advanced architecture provides
gorage of adl measurement building blocks and averaging modes. Vector averaged, RMS
averaging, unaveraged and pesk hold versons of al measurements are sSmultaneoudy
acquired and can be displayed without re-taking data.



Averaging

The SR785 comes equipped with a wide sdection of averaging techniques to
improve your sgnd to noise raio. Choose RMS averaging to reduce signd
fluctuations, vector averaging to actudly diminate noise from synchronous
sgnds, or peak hold averaging.

In the order-tracking measurement group, time averaging is avalable. Both
linear and exponential averaging is provided for each mode.

Time Capture

Source

The SR785 comes with 2 Msamples of memory (8 Msamples optiond). Anaog
waveforms can be captured a sampling rates 262 kHz or any binay sub
multiple, dlowing you to optimize sampling rate and dorage for any
gpplication. For example, 8 Msamples of memory will capture 32 seconds of
time domain data a maximum 262 kHz sample rate, or aout 9 hours of data at
a 256 Hz sample rate. Once captured, any portion of the signa can be played
back in any of the 9785s measurement groups except swept-sne. The
conveniet Auto Pan feature lets you display measurement results
synchronoudy with the corresponding portion of the cgpture buffer to identify
important features.

The SR785 comes dstandard with five precison source types. Generate low
digortion (-80 dB) sngle or two-tone sSne waves, white noise, pink noise,
chirps, and arbitrary waveforms. The chirp and noise sources can be burgted to
provide activity over a sdected portion of the time record for FFT
measurements. The digitdly synthesized source produces output levels from 0.1
mV to 5V and offsetsfrom 0 to +5 V, and ddlivers up to 100 mA of current.

Arbitrary waveform capability is standard with the SR785. Use the arbitrary
source to playback a section of a captured waveform, play a sdected FFT time
record or upload your own custom waveform from your computer.

User Math

We can creste our own measurement in each of the SR785's measurement
groups usng the math menu. Enter any equdion involving RMS averaged,
vector averaged or unaveraged time or frequency data, stored files, congtants, or
rich aray supplied operdtions including arithmetic functions, FFT, inverse FFT,
jw, d/dw, exp, In, X, and many others.



Output

Because dl the averaging modes are avalable as user math operands, non
repetable runout measurements (used in andyzing disk drives) can be
performed in a single pass by entering the eguation MAG (RMS<F1>)-MAG
(Vec<F1>). Unlike many other analyzers, the SR785's measurement rate is
virtualy unaffected when user math is selected.

The SR785's built-in 35" 144 Mb disk drive, GPIB and RS-232 computer
interfaces and centronics printer port combine to dlow admost unlimited
flexibility in saving, printing, plotting or exporting your messurement data
Displays and setups can be printed or plotted to disk, GPIB, RS-232 or
centronics port in PCX, GIF, PCL (LaserJet and DeskJet), dot matrix,
Postscript, HPGL or ASCII formats. An annotation editor lets you add text, time
and date, or filenamesto any portion of the plot.

DataViewer

The SRS DataViewer is a Windows 95 program that alows you to quickly
upload SR785 files into a grgphicd environment, perfform smple editing and
cut and paste into other applications. We can add pointers and text, change
scding, and peform smple math operations. Grgphs can be saved in PCX,
BMP or GIF formats.



Front Panel quick start

There are two types of front pand keys, which are referenced in this section. Hardkeys
are those with labels printed on them. There function is defined by labd and does not
change. Brackets like this — [Hardkey], reference hard keys. Softkeys are the ten gray
keys dong the right edge of the screen next to the key. Softkey functions change
depending upon the menu and instrument configuration. Softkeys are referenced as the
<Softkey>.

[Hardkeys]

The keypad congsts of four groups of hardkeys (keys with printed labels).

The ENTRY keys ae used to enter numeric parameters, which have been
highlighted by a softkey. The MENU keys sdect a menu of softkeys. Pressng a
menu key will change the menu boxes, which are displayed next to the softkeys.
Each menu presents a group of smilar or related parameters and functions. The
CONTROL keys sart and stop data acquisition, toggle the active display and link
parameters and functions. These keys ae not in a menu snce they are used
frequently and within any menu. The FUNCTION keys peform common
functions such as Auto Scae and Auto Range. These keys can be accessed at any
time.

<Softkeys>

The 3785 has a menu driven user interface. The menu keys each display a menu
of soft keys. The softkeys are a the right of the video display and have different
functions depending upon the displayed menu.

There are three types of softkeys — buttons, lists and numeric values. A button
perfforms a function such as <Full Span>. A list presents a list of choices or
options in the entry field (at the top of the screen). Use the knob to make a
sdection and press [Enter]. <Measurement is an example of a lis. A numeric
vaue presents the current vaue in the entry fidd and awaits numeric entry. Enter
a new vaue with the entry keys and press [Enter]. <Start Freg> is an example of a
numeric vaue.

[ALT] Keys

The [ALT] key is a specid key, which has no meaning by itsdf but instead
modifies the meaning of another key press or knob turn. Pressing the [ALT] key
toggles the gate of the ALT indicator at the top of the screen. Pressing a control
key while the ALT indicator is lit sdects the “dternae” function labeed
underneath the key instead of the normd function.



Knob

Help

The knob normdly moves the markers within the displays. If a parameter has
been highlighted by its softkey, the knob adjusts the parameter. List parameters
are most eadly modified with the knob. Numeric parameters may aso be adjusted
with the knob.

Knob ligt sdlections are referenced in parenthesis like (Hanning).

Enter the on screen hep system by pressng [Help/Locd]. Help on any hardkey or
softkey is avallable smply by pressng the key. Press [1] for the help index. Press
[0] to exit the help system and return to norma operation.



Thingsto watch out for

If the andyzer is on but doesn't seem to be taking data, there are a number of things to
check.

Sart
Press the [dart/reset] key to dart the measurements. Make sure the run/pause
indicator at the top of the screen displays ‘RUN’ instead of ‘PAUSE’. Note that
in many cases when settings are changed using the menus, the new settings will
not take effect until [sart/reset] is pressed.

Livedisplay
If the digplays are showing recalled trace data, they are off-line and do not display

the live measurement data. Set the Digplay to Live ingead of Off-line (in the
[Digplay Option] menu).

Narrow Span

If the FFT span is narrow, the time record is very long( up to 1000's of seconds).
Completdly new data is avalable only every time record. Change the Time
Record Increment in the [Average] menu to display overlapped data more often.
Averaging
Veay long averaging times for any measurement may give the appearance that the
display does not update. Check the FFT Number of Averages, the Octave
Integration Time or the Swept Sine Integration Time.
When Linear averaging is on, the messurement is paused after the average is
completed. Press [start/reset] to another average.
Scaling and Ranging

Check that the inputs are not completely overloaded by using [Auto Range Chl]
and [Auto Range Ch2)].

Scde the display to show the entire range of the data with [Auto Scde A] and
[Auto Scae B].
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L ocal

Reset

Make sure that the andyzer is not in REMOTE dae where the computer
interfaces have setup the insrument and locked out the front pand. Press the
[Loca/Help] key to restore local control.

If the andyzer 4ill seems to be functioning improperly, turn the power off and
turn it back on while holding down the [<-](backspace) key. This will reset the
andyzer into the default configuration. The anadyzer should power on running and
taking measurements.
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Analyzer Basics

What isan FFT?

An FFT andyzer tekes a time varying input sgnd, as you would see on an
oscilloscope trace, and computes its frequency spectrum. Fourier's basic theorem dates
that any waveform in the time domain can be represented by the weighted sum of pure
sne waves of dl frequencies If the dgnd in the time doman is periodic, then its
gpectrum is probably dominated by a single frequency component. The spectrum andyzer
represents the time domain sgnd by its component.

Why look a asgna’s spectrum?

For one thing, some measurements that are very hard in the time domain are very hard in
the time domain are very easy in the frequency doman. Take harmonic digtortion. It is
hard to qudify the didortion by looking & a good sne wave output from a function
generator on an oscilloscope. When the same signd is displayed on a spectrum andyzer,
the harmonic frequencies and amplitudes are displayed with amazing clarity. Another
example is noise andyss. Looking a an amplifie’s output noise on an oscilloscope
bascaly measures just the totd noise amplitude. On a spectrum andyzer, the noise as a
function of frequency is displayed. It may be that the amplifier has a problem only over
certain frequency ranges. In the time domain it would be very hard to tell.

FFT Frequency Spans

Full span is the widest frequency span corresponding to the fastest avallable sampling
rate. In the SR785, this is DC to 131 kHz using a sampling rate of 262 kHz. Because the
ggnd passes through an anti-daisng filter a the input, the entire frequency span is not
usesble. The filter has a flat response from DC to 1024 kHz and then rolls off steeply
from 102.4 kHz to 156 kHz. The range between 102.4 kHz and 131 kHz is therefore not
usesble and the actud displayed frequency span stops at 102.4 kHz.



Example M easur ements
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Analyzing a Sine Wave

This measurement investigates the spectrum of a 1.024 kHz sine wave. Y ou will use the SR785 source to

provide the sine signal (or you can use a function generator capable of providing a 1.024 kHz sine wave at
alevel of 100 mV to | V, such asthe SRS DS345). The actua settings of the generator are not important

since you will be using the SR785 to measure and anayze its outpuit.

1. Press[System]
Press <Preset>

Press [Enter] to confirm Preset.

Display the System menu.
Preset returns the unit to its default settings.

Preset requires confirmation to prevent accidental
reset. Wait until the sdlf-tests are completed.

2. Connect the Source Output to the Channel 1 A
Input.
(Or connect a function generator's output to the
Ch 1 A Input of the analyzer.)

Setup to analyze the source output.

(The input impedance of the analyzer is1 MW. The
generator may require a terminator. Many generators
have either a50 W or 600 Woutput impedance. Use
the appropriate feed through termination if
necessary. In genera, not using aterminator means
that the output amplitude will not agree with the
generator setting and the distortion may be greater
than normal.)

3. Press [Source]

Press <Sine>
Press <Fregquency 1>

Press [1][.][0][2][4], select (kHZ) with the
knob, and press [Enter].

Press <On>

(Or
Turn on the generator, set the frequency to
1.024 kHz and the amplitude to approximately

I Vrms.)

Select the Source menu.
Choose Sine outpuit.

Adjust the output Frequency.

Enter 1.024 kHz for the Frequency. Enter the value
with the numeric entry keys. Select the units with
the knob. Enter the new vaue with the [Enter) key.

Turn the source on. When the instrument is turned
on, the source is aways off.

(Setup the function generator for 1.024 kHz sine
output.)

4. Press [Auto Range Ch ]

Let the analyzer automatically set the Input Range
to agree with the signal (either from the Source or
runction generator). Note that the Ch | Input Range
readout at the top of the screen isdisplayed in
inverse when Chl Auto Range is on.
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5. Press [Freq]

Press <Span>

Use the knob to adjust the Span to 6.4 kHz and
press [Enter].

Select the Frequency menu.
Adjust the FFT Span.

Set the Span to display the signal and its first few
harmonies.

6. Press [Display Optiong]
Press <Format>

Sdlect (Single) with the knob and press [Enter].

Select the Display Options menu.

Choose a new Display Format.

Select the desired option from the displayed list and
press [Enter]. Single Display Format shows asingle

large graph.

7. Press[Auto Scale A]

Press [Marker Max]

Automatically scale Display A (the active display)
to show the entire range of the measurement.

This moves the Marker to the maximum data point
in the active display (A). The Marker should now
be on the 1.024 kHz signal. The Marker Position
shown above the graph displays the frequency and
amplitude of the signdl.

8. Use the knob to move the Marker around. Take &
look at some of the harmonics.

The knob normally adjusts the Marker Position
within the active display (Display A inthiscase). If
amenu box is highlighted with a soft key, the knob
adjusts the selected parameter shown in the entry
field at the top of the screen.

9. Let'slook at the fundamental only.
Press [ Span Down] twice to decrease the Span

to 1.6 kHz. The Stop Frequency shown at the
bottom right of the graph should read 1.6kHz.

Press [Marker Max]

Press [Marker Center]

Y ou can aso use the [Span Up] and [Span Down]
keys to adjust the Span.

Thisisolates the 1.024 kHz fundamenta frequency.
Y ou may notice that the spectrum takes a noticeable
time to settle at this last span. Thisis because the
time record is 250 mslong.

Move the Marker to the peak.

This sets the span Center Frequency to the Marker
Position (for the active display). The signa will be
at the center of the span. Further adjustments to the
span will keep the center frequency fixed.

10. Let'slook at the signd distortion.

Press [Freq]

Select the Frequency menu.
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Press <Span>

Enter [1] [2].[8], select (kHz) with the knob,
and press [Enter].

Press [Auto Scale A]

Adjust the Span.

Y ou can aso use the numeric keypad to enter the
span. .

Enter the 12.8 kHz span numerically. Note that the
Center Frequency isno longer 1.024 kHz. Thisis
because a 12.8 kHz span cannot be centered below
6.4 kHz without starting at a negative frequency.

Adjust the graph scale and reference to display the
entire range of the data. This key can be used at any
fime.

11.L et's measure some harmonies using the Marker
Reference.

Press [Marker Max]

Press [Marker Ref]

Use the knob to move the Marker to the
harmonies.

Press [Marker Ref]

Move the Marker to the fundamental peak.

Set the Marker Offset or Reference to the amplitude
of the fundamental. The Marker Position above the
graph now reads relative to this offset

¢~O dB). Thisisindicated by the A in front of the
Marker Position reading. A small flag shaped

symbol is located at the screen location of the
reference.

The Marker Position shows the distortion peaks
relative to the fundamenta.

Pressing [Marker Ref] again removes the Marker
Offset and returns the Marker to absol ute readings.

12. Let’s have the analyzer measure the
digtortion
Press [Marker]

Press <M ode>

Select (Harmonic) with the knob and press
[Enter].

Press <# Harmonics>

Use the knob to adjust the Number Of
Harmonics to 10 and press [Enter].

| Select the Marker menu.

Adjust the Marker Mode.

Choose the Harmonic Marker for the active display,

Adjust the Number Of Harmonics for anaysis,

Enter 10 harmonies.

16



Press[Marker Max]

Move the Marker to the peak (fundamental).

Notice that Harmonic Markers (little triangles)
appear on top of dl of the harmonic peaks. These
indicate which data points are used in the harmonic
calculations.

The harmonic calculations are displayed within the
menu. THD (total harmonic distortion) isrelative to
the fundamental. Harmonic power is an absolute
measurement of the harmonic power levd.

This concludes this measurement example. Y ou
should have afeeling for the basic operation of the
menus, knob and numeric entry, rnarker movement

and some function keys.
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Measuring a Frequency Response Function

This example investigates the frequency response of the test filter (enclosed with this manua) using FFT
measurements. Y ou will use the SR785 source to provide a broadband chirp and both input channels to
measure the input to and output from the device under test.

1. Press [System|
Press <Preset>

Press [Enter] to confirm Preset.

Display the System menu,
Preset returns the unit to its default settings.

Preset requires confirmation to prevent accidental
reset. Wait until the self-tests are completed.

2. Use aBNC Tee to connect the Source Output to
the filter input and the Ch | A Input.

Connect the filter output to the Ch2 A Input.

Erequency Response is defined as Ch2 response
divided by the Ch | reference. Thus, Ch | monitors
the filter input (source output) and Ch2 measures
the response of the device under test.

3. Press [Source]

Press <Chirp>

Press <On>
Press [Window]

Press <Window>

Select (Uniform) with the knob and press
[Enter].

Select the Source menu,

Choose Chirp output. The output is an equal
amplitude sine wave at each frequency bin of the
FFT spectrum.

Turn the source On. Select
the Window menu,

Adjust the FFT Window function.

The Chirp source requires the use of the Uniform
window since not all chirp frequency components
are present at al points in the time record. The
chirp is exactly periodic with the FFT time record
and does not ‘leak’ with the uniform window.

4. Press [Auto Range Chl]

Let the analyzer automatically set the Input Ranges
to agree with the signals. Note that the Input Range

Press [Auto Range Ch2] readouts at the top’ of the screen are displayed in
inverse when Auto Range is on.
5. Press[Freq] Select the Frequency menu.
Press <Span> Adjust the FFT Span.

Use the knab to adjust the Span to 6.4 kHz and
press [Enter].
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Thetop display (A) is measuring the filter input and
should show afairly flat spectrum. The bottom
display (B) is measuring the filter output and should
show a deep notch.

Both displays are measuring absolute signal levels.

6. Press [Display Setup]
Press <M easurement>

Sdlect (Freg. Resp.) with the knob and press
[Enter].

Press [Auto Scale A]

Select the Display Setup menu.

Adjust the Measurement of the active display (A).

Choose Frequency Response for the Measurement
in Display A (top).

Frequency Response is the ratio of the response
(Ch2) to the input (Chl) and is a unit less quantity.

Adjust the scale and reference for Display A to
show the entire range of the data.

7. Press [Marker]

Press <Width>
Select (Normal) with the knob and press [Enter].

Press <Seeks>
Select (Min) with the knob and press [Enter].

Move the Marker Region with the knob to find
the notch frequency and depth. Or press [Markel
Min].

Select the Marker menu.
Adjust the Marker Width for Display A.
Change to Normd Width (1/2 division).

Adjust what the Marker Seeks within the Marker
Region.

Seek the Minimum of the data within the Marker
Region.

The Marker Region makes it easy to find narrow
peaks and valeys in the graph. The notch should be
around | kHz and about -60 dB deep.

8. Press (Display Options]
Press <X-Axis>

Press <Link>

Select (Log) with the knob and press [Enter].

Select the Digplay Options menu.
The graph might look better on alog x axis.

The <Link> key lets you make a choice for both
displays. We want both displays on alog x-axis.
Note that the linkage indicator at the top of the
screen changes from Disp A to Link.

Log scdeisacommon way to display filter response
functions. Note that both displays now have log x-
axes.
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9. Let's show phase response on Display B The two displays have separate Measurements.
(bottom).

Press [Active Display] Make Display B the active display. The active
display hasits Marker Position Bar (above the
graph) highlighted.

Press [Display Setup] Select the Display Setup menu. The setup of
Display B (the active display) is now shown in the
menu.

Press <Measurement> Adjust the Measurement of Display B.

Select (<Freg. Resp.>) with the knob and press | Choose Frequency Response also.
[Enter].

Press <View> The measured datais a set of complex values, which
can be viewed in a number of different ways.

Select (Phase) with the knob and press [Enter]. | Choose Phasewview to show the phase of the
transfer function.

Press [Auto Scale BJ Scale Display B to show the entire phase transfer
function.

10.. Let'slink the Markers together.

Press [Active Display] Make Display A (top) the active display.
Press [Marker] Select the Marker menu.
Press <Width> Adjust the Marker Width of Display A.

Select (Spot) with the knob and press [Enter]. Change the Marker Width to Spot.

11 .Press[Link] and use the knob to move the The [Link] key links the two display markers
marker. together. This allows simultaneous readout of
Transfer Function Magnitude (top) and Phase

(bottom).

Press [Enter] |Pressing any key removes the linkage between the |
markers.

To permanently link the Markers, go to the
Marker menu.

Press [Marker] Select the Marker menu.
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Press <Marker>
Select (Link) with the knob and press [Enter].

Move the Marker with the knob.

Adjust the Marker Type.

Linked Markers move together. Since we changed
the Display A Marker to Linked, moving the
Display A Marker moves the Display B Marker.

If Display B is active, moving its Marker does not
move the Display A Marker. To do this, change the
Display B Marker Type to Linked aso.

This concludes this measurement example. You
should have afeding for the basic operation of two
channel measurements and the use of [Active

Display].
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Linking (Advanced Operation)

This example investigates the test filter (enclosed with this manual) using FFT measurements. Y ou will
use the SR785 source to provide a broadband source and both dismays to measure the output of the
device under test. Display parameter linking and function linking will be explored in greater detail.

1. Press[System]

Press <Preset>

Press [Enter] to confirm Preset.

Display the System menu.
Preset returns the unit to its default settings.

Preset requires confirmation to prevent accidental
reset. Wait until the self-tests are compl eted.

2. Connect the Source Output to the filter input.

Connect the filter output to the Ch2 A Input.

In this example, only the filter output on Channel 2 .
is required.

3. Press [Source]

Press <Noise>

Press <On>
Press <Type>

Select (White) with the knob and press [Enter].

Select the Source menu.

Choose Noise output. The output is random noise.

Turn the source on.
Adjust the Noise Type.

This source is White Noise which extends over the
entire 0-102.4 kHz frequency range.

4. Press [Auto Range Ch2]

Let the analyzer automatically set the Input Range
to agree with the signal. Note that the Input Range
readouts at the top of the screen are displayed in
inverse when Auto Range ison.

5. Press [Display Setup]
Press <M easurement>

Select (FFT ch2) with the knob and press
[Enter].

Select the Display Setup menu.
Change the Measurement of the active display (A).
Choose FFT spectrum of Ch2 for the measurement

in DisplayA (top). Both displays are independently
measuring the filter output spectrum.

6. Press [Input]
Press <Analyzer Config>

Select the Input Menu
Change the way the input channels are used.



Select (Independent Chan.)

In this example we'll want to set separate frequency
spans for the two displays. To do that the analyzer
must be in the Independent Channels mode. In the
default Dual Channel mode the span is the same for
both channels, but dual channel measurements are
alowed.

7. Press [Freq]

Press <Span>

Use the knob to adjust the Span to 12.8 kHz and
press [Enter).

Press <Span> again.

Press [Link]

Use the knob to adjust the Span to 3.2kHz and
press [Enter].

Highlight the Span. Note that the Link indicator at
the top of the screen turns on. This indicates that the
highlighted parameter (Span) is linked to both
displays. Changing alinked parameter affects both
displays at once.

Narrow the Span of both displays to show the filter
notch at | kHz (noisy of course).

Highlight the Span again.

| Pressing [Link] toggles parameter linking off. The

Link indicator now shows 'DispA’ indicating that
this menu box adjusts the span for Display A only.

Change the Span of Display A to 3.2 kHz. The Spar
of Display A remainsat 12.8 kHz. The SR785

alows the two displays to have differing Spans and
Start frequencies in the Independent Channels mode.

M any parameters affect the displays separately.
Linking is a convenient way to adjust the two
displays together and keep their settings the same.

The default settings link many measurement
parameters, such as frequency and averaging,
together as found in many other instruments.

8. Press [Average]

Press <Display Avg>

Select (RMYS) with the knob and press [Enter].

Select the Average menu.

Select the averaging mode to display. The SR785
always computes all the averaging modes when
<Compute Avgs> is set to Yes. The <Display Avg>
softkey selects which averaging mode is currently

displayed.

Select RMS Averaging for both displays.
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Press <# Avgs>

Press [Link]

Press[2] [O] and press [Enter].

Change the number Of Averages for Display A.

Unlink the Number Of Averages. 'DispA' is shown
on the Link indicator.

Change the Number Of Averages for Display A to
20 (instead of 2). Display A will average for 10
times as many measurements as Display B and be
quite a bit smoother.

9. Press [Active Display]

Press [Window]
Press <Window>
Press [Link]

Select (Hanning) with the knob and press
[Enter].

Let's change the Window for Display B. Make
Display B the active display.

Sdlect the Window menu.
The windows are linked by defaullt.

Unlink the Window type. 'DispB' is shown as the
Link indicator.

Display B is now using the Hanning window while
Display A is dill using the BMH window.

So far we have unlinked measurement parameters.
Frequency Span, Averaging and Window type
affect the actual measurements within the displays.
Most analyzers do not allow these measurement
parameters to be unlinked.

Display parameters, such as Scaling, Views, Units
and Marker functions, are usualy unlinked.
However, linking them can be a convenient way to
adjust graph parameters together with a minimum
of key presses.

10. Press [Display Setup]
Press <Units>

Press <Pk Units>
Press [Link]

Select (rms) with the knob and press [Enter].

Select the Display Setup menu.
Enter the Units

Select between peak, rms and peak-to-peak units.
Link the Pk Units parameter (default is unlinked).

Both displays Units become dBVrms with asingle
parameter entry. The Pk Units remain linked until
unlinked with the [Link] key.

11. Press <Return>
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Press <y Max>

Press[Link]

Press [-] [1] [O] and press [Enter]

Press [Auto Scale A]

Press [Link] and then [Auto Scale A]

Let's change the Top Reference of the graphs.
Link the Y Max parameter (default is unlinked).

Change the Top Reference of both graphs to
-10 dBVrmswith asingle entry.

Change the scale of Display A to center the data.

Another simple way to adjust the scales of both
graphsis using the Auto Scae keys.

Pressing [Link] [Auto Scale A] first auto scales
Display A and then changes the scale of Display B to
match. Thisis convenient when you are comparing
the two displays.

12 Press [Link] and use the knob to move the
Marker. Both Markers move together when
linked.

Press [Enter]

Press [Marker Min]

Press [Link] then [Marker Min]

The[Link] key temporarily links the two display
Markers together.

Pressing any key removes the link between the
Markers.

To permanently link the markers, go to the Marker
menu and change <Marker> to Link.

[Marker Min] moves the Marker in the active
display (B) to the graph minimum.

Pressing [Link] first moves both Markers to their
graph minimums at the same time.

[Link] preceding a function key generdly performs
the function on both displays a once. [Link] [Auto
Scale] matches the active display. [Span Up] and
(Span Down] are aways linked.

This concludes this measurement example. You
should have afedling for linking and unlinking and
the flexibility of unlinked measurements.
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User Math Functions

This example measures the group delay of the test filter (enclosed with this manua) using User Math
Functions. Y ou will use the SR785 source to provide a broadband source and both displays to measure
the output of the device under test.

1 Press[System] Display the System menu.
Press <Preset> Preset returns the unit to its default settings.
Press [Enter] to confirm Preset. Preset requires confirmation to prevent accidental

reset. Wait until the self-tests are completed.

2. Use aBNC Tee to connect the Source Output tq In this instrument, transfer function is defined as

the filter input and the Ch | A Input. Ch2 response over Chl reference. Thus, Chl
monitors the filter input (source output) and Ch2

Connect the filter output to the Ch2 A Inpuit. measures the response of the device under test.

3. Press [Source] Select the Source menu.

Press <On> Turn on the source.

Press <Chirp> Choose Chirp output. The output is an equal
amplitude sine wave at each frequency bin of the
FFT spectrum.

Press [Window] Sdlect the Window menu.

Press <Window> Adjust the FFT Window function.

Select (Uniform) with the knob and press The Chirp source requires the use of the Uniform

[Enter]. window since not al chirp frequency components

are present at al pointsin the time record. The
chirp is exactly periodic with the FFT time record
and does not 'lesk’ with the uniform window.

4. Press [Auto Range Ch 1] Let the analyzer automatically set the Input Ranges
to agree with the signals. Note that the Input Range
Press [Auto Range Ch2] readouts at the top of the screen are displayed in
inverse when Auto Range is on.
5. Press [Freq] Select the Frequency menu.
Press <Span> Adjust the FFT Span

Use the knob to adjust the Spanto 6.4 kHz and | Set the Span to display the filter notch at 1 kHz.
press [Enter].
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The top display (A) is measuring the filter input and
should show afairly flat spectrum. The bottom
display (B) is measuring the filter output and should
show a deep notch.

Both digplays are measuring absolute signal levels.

6. Press [User Math]

Press <Function>

Use the knob to select (.FFT UsrFn2) and press
[Enter].

Press <Edit Fn>

Press <Operands>

Use the knob to highlight FFT(2) and press
[Enter].

Use the knab to highlight / (divide) and press
[Enter].

Use the knob to highlight FFT(1) and press
[Enter].

Press <Function String>

Sdlect the User Math menu.

Choose one of the five user functions availablein
the FFF measurement group.

Select Function? to edit.

Show the Edit Function menu.

The display shows the available operands for this
function.

Use <Operands> and <Operations> to switch the
display between operands and operators.

Use the knob to highlight the desired box and press
[Enter] to insert the selection into the function string
at the top of the screen.

Choose FFT(2) asthe first operand. Thisisthe FFT
of Ch2 and isidentical to the norma measurement.

1 We are going to define atransfer function

(FFF2/FFFI).

As soon as the operand is entered, the display
switches to show operations.

Choose the divide operation next.
The display switches back to operands.

Y ou can choose another operation instead by
yressing <Operations>.

Choose FFT(1) as the denominator of the transfer
function.

This key moves the marker to the function string at

ghe top of the screen. This allows you to delete terms
and insert new ones.
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Use the knob to move the insertion point to the
beginning of the function (highlight FFT2).

Press <Operations>

Use the knob to highlight GrpDly and press
[Enter].

Move to the start of the string by highlighting the
First term (FFT2).

'Ins above the function string indicates that new
terms will be inserted before the highlighted term.
'Rep'’ indicates that the new term replaces the
highlighted one. Use <Insert/Replace> to toggle
between insert and replace.

Insert the Group Delay operator in front of the
transfer function.

Closing parentheses are not required (if they are at

the very end of the string).
Press <Enter Eq.> Enter the equation,
7. Press [Display Setup] Select the Display Setup menu.

Press <Measurement>

Use the knob to select (FFrUsrFn2) and press
[Enter].

Press <View>
Use the knab to select (Real Part) and press

[Enter].

Press [Auto Scale A]

Change the measurement of the active display
(DisplayA).

Choose FFT User Function?2.

Change the view. Group delay is the derivative of
the phase with respect to w and is areal time.

Choose Redl Part. The units automatically switch to
linear units.

User Functions are dimensionless quantities. You
can choose dB logarithmic) or units (linear).

Scale the display.

The group delay is the delay time caused by the
filter at different frequencies. The data values are
seconds of delay. Most points are in the
neighborhood of 10t0 600 i s.

At the 1 kHz notch, the group delay has a
singularity. Remember, the notch filter has a phase
discontinuity at the notch frequency.
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8. Press [Display Options]

Press <d/dx Window>

Press[.] [1] [Enter]

Press[2] [Enter]

Select the Display Options menu.

The group delay is the derivative of the phase. The
derivative operation requires an aperture or
window.

Set the window to 0.1% of the display length. This
increases the resolution (makes things narrower) of
the graph while decreasing the smoothing of noisy
data.

Set the window to 2%. This decreases the resolution
(makes thing wider) while increasing the smoothing
of noisy data.

This concludes this example. User Functions alow
you to define your own measurements starting with
the basic SR785 measurements. User Functions can
also use stored trace data (for calibrations and

normalizations) and user constants.
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Model 5184 Ultra Low Noise Amplifier

The modd 5184 is a medium-impedance (5 MW), AC-coupled, voltage
preamplifier which features an ultra low-noise FET input stage (800 pV/O Hz a 1 kHZ).
It has a frequency range of 0.5 Hz to 1 MHz and fixed gain of 60 dB (" 1000).
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I ntroduction

The Modd 5184 preamplifier can be powered from an externa power source or
from internd akdine cdls as sdected from the front pand switch. In operdtion,
the voltage to be messured is connected to the AC- coupled INPUT BNC
connector. The preamplifier amplifies the sgnd voltage by a fixed 60 dB (1000
times), which is then output from the OUTPUT BNC connector.

Power Switch

The three postion POWER switch dlows EXTERNAL, OFF, or BATTERY to
be sdlected. To operate the 5184 from interna batteries, set the switch to the down
position. The status of the selected power source can be ascertained by pressng
the POWER TEST button; the adjacent LED will light if the power source
voltage, whether of the external power source or the 5184 internd batteries, is
above the minimum required vaue for reliable operation.

I nput

The 5184 input crcuit is of asymmetricd differentid configuration. When the
GROUND/ISOLATE switch is set to the down (GROUND) position, the screen
of the BNC input socket is grounded and the input may be used in the
convertiond dngle-ended mode. When the GROUND/ISOLATE switch is st to
the up (ISOLATE) postion, the input stage is floated and the input may be used
in the “pseudo-differentid” mode. In “pseudo-differentid” mode the sgnd
voltages should be connected to the BNC INPUT socket and the signa ground to
the GROUND termind on the front pand. The maximum common mode input
voltage is 300-mV pesk to pesk and the maximum voltage difference the shell of
the BNC signasinput connector and the front panel ground termind is+600 mV.

Output

The 5184 output can generate greater than 10 V pesk to pesk signds into loads
greater than 100 KW.

Battery operation

In battery powered operation, the 5184 requires four 9 V dkaine cels. Each
battery fits into its avn removable tray accessible from the rear pand. When they
are exhausted, al four batteries should be replaced together. Care should be taken
when exchanging the batteries to observe the correct polarity, which is marked on
the indde of the battery trays and the top of the batteries. The batteries will
provide up to eight hours operation at 1 V rms. output level.
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SR 715/720 LCR meter

This section is designed to help the user begin making measurements with the SR715/720
LCR meter and to familiarize them with some of its festures.

To operate the SR715/720, first verify that the correct line voltage has been sdected on
the power entry module on the rear pand. Veify that no parts are in the fixture, the units
«df tes routine will fal if any componets are in the test fixture. After connecting the
line cord to the power entry module, switch on the power switch, located on the rear right
hand gde of the unit. The unit will display the ROM versdon on the left disilay and the
serid number on the right display for aout 3 seconds. Next the unit will begin its sdf-
test procedure. If dl the tests are OK, ‘tEST PASS will be displayed. Press [Recall] [O]
[ENTER], to recdl the default setup. Thiswill set the unit asfollows:

Parameter AUTO
Frequency 1 kHz
Drive Voltage 10Vrms
Bias OFF
Measurement Rate SLOW
Averaging OFF
Range Hold OFF
Equivdent Circuit SERIES
Display VALUE
Trigger Mode CONT
Binning OFF

At this point a part can be placed in the fixture and measurements can be made. The unit
will automaticaly decide which type of component is in the fixture (R, C or L), change to
the correct range, and display the part vaue with the correct units. If any of the test
conditions need to be changed for a measurement, press the appropriate keys. Most
functions are easy to change, but if more information is needed, refer to the Operating
manua and programming reference.

The SR715/720 comes with a build in fixture for measuring radid leaded components,
like most capacitors, and adapters for messuring axial leaded components, like most
resstors. To measure a radia leaded component, remove any adapters and put one lead of
the component in each sde of the fixture. To measure an axid leaded component, firgt
inddl the fixture adgpters. Put the adapters on in the middle of each sde of the fixture,
and then dide them until the appropriate distance separates them. Insart the one lead of
the component into each sde of the fixture.

Note After changing the fixture configuration it is a good idea to perform an open and
short circuit cdibration. (See Operation section of the operating and reference manual)

Note: if biased measurements are being made on capacitors, be certain that the part is
ingalled with the correct polarity, as marked on the unit.
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Typical measurement setups

The table below lists suggested test conditions for various types of components. This is
by no means the only set of conditions for measuring, but is a good generd “rule of

thumb”.
Setupsfor measuring Typical Parts
Component Value Parameter Equivalent Frequency
Type Type Circuit
Unknown: Any Auto Series 1 kHz
Resgtors. <1kW R+Q Series 1kHz
> 1 kW R+Q Series 100 or 200 Hz
Inductors: <10nH L+Q Series 100 kHz
10mMH-1mH L+Q Series 10 kHz
ImH-1H L+Q Series 1kHz
>1H L+Q Series 100 or 120 Hz
Capacitors. <10 pF C+D Parald 10 kHz
10pF—-400pF [C+D Series or Pardld 10 kHz
400 pF -1 nF C+D Series 1 kHz
>1nF C+RorC+D | Seies 100 Or 200 Hz




Overview

This section gives the overdl view of the SR715/720. For detall operating information on
specific features, see the operating and programming reference.

Display

The led display shows vaues, entered parameters, instrument status, and user messages.
There are two 5-digit LED displays and 25 indicators LEDs. When making normd
measurements, the magor parameter (L, C, or R) is shown on the left display and
gppropriate minor parameter (Q, D or R) is shown on the lft display.

Fixture

A verstile test fixture is provided with the SR715/720 that provides a 4 wire Kevin
connection uses two wires to cary the tes current to and from the device and two
independent wires to sense the voltage across the device. This prevents the voltage drop
in the current carrying wires from affecting the voltage messurement.

Radia leaded components (where the leads are on the same sde) are Smply inserted into
the test fixture, onelead in each Sde.

Axia leaded devices (leads at opposite ends) require the use of the axid fixture adapters.
Surface mount (SMD) devices or components with large or unusualy shaped leads can
be measures with SMD tweezers or Kevin cdips. A BNC adapter is avalable for
interfacing to remote fixtures.

If the device leads are dirty or coated with wax, clean them before insarting them in the
fixture. See the maintenance section for information about cleaning the fixture.

The figures on the next page show the mounting of the component on the fixture.



Axial Fixture (with part)

Radial Fixture (with part)



Keypad

Keypad
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The keypad is used to sdect measurement conditions and to enter values. LEDs indicate
the actual measurement condition.

Parameter
The [R+Q], [C+D], [C+R], and [AUTQ] keys select the parameter being measured. The
selected parameter pair isindicated above the mgor and minor parametersin the display.

If AUTO is sdected, the unit will select themost gppropriate parameter pair and turn on
the AUTO LED above the mgjor parameter display.

Frequency
The [UP Arrow] and [DOWN Arrow] keys sdlect one of the available frequencies.

Drive Volt
The [Sdlect] keys cycles through the three output drive voltages.

Mess Rate

The [Rate] key selects adow, medium or fast measurement. These rates corresponds to
2, 10, or 20 measurement frequencies of 1 kHz or higher.



Average

The[Average] key places unit in the averaging mode. Pressing it second time returns the
unit to the non-averaged mode. The number of readings averaged is set to between 2 and
10 from the entry display.

Range Hold

[Range Hold] holds the unit its current measurement range. Pressing the key a second

time returns the unit to autoranging or normal mode. The reange can dso be entered with
the numeric keysin the entry display.

Display

The [Display] key sdlects the parameter on the display. Pressing [Display] cycles through
the available display types.

Store and Recdll

The unit can store up to 9 complete instrument setups in non-volatile memory. To store

the present configuration as setup #n, press [Store][n][ENTER] where n ranges from 1

through 9. to reacd an instrument configuration, press [Recadl][n][ENTER]. Recal O

returns the instrument to its default values.

Power switch

The power switch is located on the rear right Sde of the unit. Depressing the front side of
the switch turns the unit on.

RS232 DB25 and | EEE-488 (GPIB) Connector

This connector alows for computer control of the unit over an R232 interface. This
connector alows for computer control of the unit over the GPIB or |EEE-488 interface.
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Chapter 4

Noise M easurement Experiment:

After getting familiar with the individua insrument its time to use the capatiilities of

these equipment to measure the noise sgnd. Following are the steps to measure one over
f noise and then store the Sgnd in the memory and externd floppy disk. Y our experience
from the three experiments discussed in chapter one will be ussful here.

To measure background noise: the FFT of the background noise is obtained when the
entire system is operating with no d.c. current passing through the thin film. This
gpectrum is captured and stored in the Dynamic Signd Andyzer.

Next, the voltage noise spectrum is obtained when d.c. current is applied to the test
device, this spectrum is also captured and stored in the Sgnal analyzer.

Using features (user Math Functions) of SR785 Dynamic Signd Andyzer, background
noise spectral dendity is subtracted from tota noise voltage spectra dengty i.e. Sv(tota)
— Sv(bgn) and the remainder is the excess noise produced by the thin film.

Before following the steps given below make the connections as given in the block
diagram of the noise measurement system.

Block Diagram of noise measurement setup
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Steps: Under No d.c. current flowing through the sample

Press[System]

Press<Preset>

[Enter] to confirm preset.

Press [Auto Range Chl]

Press[Auto Range Ch2]

Press [Display Setup]

Press <Measurement>

Sdlect (FFT chl) with the knob and press [Enter].
Press[Active Display]

10.  Sdect (FFT ch2) with the knob and press [Enter]
11. Press [Input]

12. Press <Andyzer Config>

13.  Sdect (Independent Chan.)

14. Press[Active Display]--- ch-1

15. Press[Freq]

16. Press <Span> (400 Hz.)

17. Press <Start freg>-- 3Hz

18. Press < Stop Freq >-- 400 Hz.

19. Press[Active Display]

20. Follow steps 22 to 25

21. Press [Window]

22. Select (Flattop) and Press [Enter]

23.  Press[Average]

24. Press<Display Avg>

25. Sdect (RMS) with the knob and press [Enter]
26. Press <# Avgs>

27. Press[Link]

28.  Sdect No. Of Averages—30

29. Press[Active Diglay]

30.  Presy Link]—Disp B is highlighted

31.  Sdect (Peak Hold) for ch-2, seect same parameters for ch-2.

WCoNOUOR~WNPE
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To SAVE and RECALL the waveform stored in the TRACE:

WoNo~wWNE

Press[Alt] [Print Screen]—to save current data in the active display to atrace.

Use the knob to sdlect Trace 3 and press [Enter]
Press [Active Display] —Switch to Disp B

Do step 1 and 2 and store in Trace 4.

To Recdl Press[Alt] [Help/Locd]

PresgLink]

Press [Enter] to select Trace3onch-1

Presq Link ]

Sdlect Trace 4 on ch-2.

Put a blank floppy

Press [DisK]

Press <Disk Upkeep>

Press<Format Floppy> and Press [Enter] to confirm
Press <Return>

Press [Active Display] to make ch-1 display active
Press <File Name>

Press[Alt]

Enter afile name

Press< Display to Disk >

Press [Active Digplay]

Press <File Name>

Enter file name

Press< Digplay to Disk>

To recall from disk Press [DisK]

Press <File Name>

Turn the knob to display the file catalog

Use the knob to sdlect one of the disk files and Press [Enter]

Press <Disk to Display>.



Use SR785 to CAPTURE asgnd and then andyzeit from MEM ORY.

Press [Capture]

Press <Allocate Memory>

Press <Waterfdl Memory>

Presq 0] and [Enter]—free memory occupied by other buffers
Press <Capture Memory>

Press[9][0][0] and [Enter]—select 900 blocks each block = 2000 points.
Press < Confirm Allocation > and [Enter]

Press <Capture Channels>

Use knob to select (Chl) and Press [Enter]

10. Press <Capture length>

11. Press[1][8][0][0] and [Enter]

12. Press[Start Capture] -- Takes 7.03 seconds

13. Unplug the sgnd from the CH1 input

14. Press[Input]

15. Press <Input Source>

16. Use knob to select (playback) and Press [Enter]

17. Press <Playback Config>

18.  Press[1][8][0][O]

19. Press <Playback Mode>

20. Use the knob to select (Circular) and Press [Enter]

CoOoNO O~ WNE

Note: Repeat the same same procedure for measuring total spectral density when d.c.
current is flowing. Then make use of User Math Function( refer examples) to obtain the
difference,
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